






АНОТАЦІЯ 

 

Герасимчук Ю.Ю. «Розробка лабораторного блока живлення на 

мікросхемі L4960». Кваліфікаційна робота бакалавра// Тернопільський 

національний технічний університет імені Івана Пулюя, факультет 

прикладних інформаційних технологій та електроінженерії, група РАс-41. 

//Тернопіль, 2024.//с.-56, рис.-29, табл.-8, бібліог,-29 , додат.- 7. 

Ключові слова: БЛОК ЖИВЛЕННЯ, СТРУМ ЗАРЯДУ, ВИХІДНА 

НАПРУГА, СТРУМ СПОЖИВАННЯ, ВХІДНИЙ ТРАСНФОРМАТОР. 

У розділі кваліфікаційної роботи представлено огляд призначення, 

області застосування та технічних вимог до розробленого радіопристрою. 

Було здійснено відбір елементної бази, розкрито принцип роботи за 

допомогою електричної схеми, проведено аналіз її функціонування, виконано 

розрахунок електричних параметрів окремих каскадів і обґрунтовано 

конструкцію виробу.  

У графічній частині роботи використано п’ять аркушів формату А2. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



ANNOTATION 

 

Herasymchuk Yu.Yu. "Development of a laboratory power supply unit on 

the L4960 microcircuit". Bachelor's qualification thesis// Ternopil National 

Technical University named after Ivan Pulyu, faculty of applied information 

technologies and electrical engineering, group RAs-41. //Ternopil, 2024.//p.-56, 

fig.-29, table-8, bibliography,-29, addendum-7. 

Key words: POWER UNIT, CHARGE CURRENT, OUTPUT VOLTAGE, 

CURRENT CONSUMPTION, INPUT TRANSFORMER. 

The section of the qualification work presents an overview of the purpose, 

field of application and technical requirements for the developed radio device. The 

elemental base was selected, the principle of operation was revealed with the help 

of an electrical circuit, its functioning was analyzed, the electrical parameters of 

individual cascades were calculated, and the design of the product was 

substantiated. 

Five sheets of A2 format were used in the graphic part of the work. 
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Вступ 

 

Актуальність роботи. У сучасній епосі імпульсні джерела живлення 

активно замінюють застарілі лінійні. Це через їх високу продуктивність, 

компактність та поліпшені показники стабілізації. З різкими змінами у 

принципах живлення електроніки в останні роки інформація про розрахунок, 

побудову і використання імпульсних джерел живлення стає все більш 

актуальною. 

Перший імпульсний блок живлення був двотактним або однотактним 

перетворювачем. У двотактному процес генерації складається з двох частин, 

де по черзі відкриваються та закриваються два транзистори. У випадку 

однотактного перетворювача, один транзистор відкривається і закривається. 

Загалом, тема імпульсних джерел живлення є дуже актуальною і 

цікавою, що робить її однією з ключових областей силової електроніки. Цей 

напрямок постійно розвивається з метою створення потужних пристроїв 

живлення, що відповідають сучасним вимогам надійності, якості, 

довговічності та мінімізації розмірів та витрат енергії і матеріалів. Майже всі 

сучасні електронні пристрої, включаючи комп'ютери, аудіо- та 

відеоапаратуру, живляться від компактних імпульсних блоків живлення, що 

підкреслює актуальність подальшого розвитку цієї галузі. 

Ступінь наукової розробки. Останнім часом серед фахівців у галузі 

електроніки та радіотехніки, а також у промисловому виробництві, імпульсні 

джерела живлення набули великої популярності. Вони відзначаються 

малогабаритними конструкціями, що призвели до відмови від традиційних 

громіздких трансформаторних блоків на користь імпульсних. 

Метою кваліфікаційної роботи є виконання пакету креслень та 

розробка опису роботи приладу блока живлення на мікросхемі L4960. 

Об'єкт є лабораторний блок живлення, який призначений для 

забезпечення живлення електронних пристроїв у лабораторних умовах. 

Зазвичай такі блоки можуть надавати різні рівні напруги та струму з 
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можливістю регулювання, що дозволяє випробувати, налаштувати і вивчити 

різноманітні електронні схеми та пристрої. 

Предмет є схема електрична принципова пристрою та опис схеми згідно 

завдання. 

Практичне значення одержаних результатів створено набір креслень 

лабораторного блока живлення. Проведено аналіз схеми та вдосконалено її, 

вибрано сучасні компоненти та створено тривимірну модель вузла пристрою. 
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Розділ 1 Основна частина 

 

1.1  Аналіз технічного завдання 

 

Технічні характеристики приладу: 

1. Напруга живлення……………………………………....…..…220В; 

2. Частота електромережі, Гц…………………………………50±10%; 

3. Допустима вологість, %...................................................................94; 

4. Вихідна напруга………..……..……………...……..…5..18В ±10%; 

5. Вихідний струм …………………………………………..2.5А ±10; 

6. Макс.споживана потужність …………..………………… до 25Вт; 

7. Маса…………………………………………………………….0,7 кг; 

8. Габаритні розміри …………………………………84х115х135 мм 

9. Діапазон робочих температур…………….……….…..-10…+30°С; 

10. ККД……………………………………………………………….80%. 

 

1.2 Аналіз структурної схеми виробу     

 

Схема Е1 лабораторного блока живлення буде складатися з мережевого 

фільтра, трансформатора для пониження напруги, випрямляча напруги, 

мікросхеми стабілізатора напруги, системи захисту від КЗ, регулятора напруги 

виконаного на резисторі, вольтметра для визначення напруги та підключення 

навантаження XS1. 

 

Рисунок 1.1- Схема Е1 лабораторного блока живлення 
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1.3 Опис принципу роботи схеми електричної принципової  та її аналіз 

 

 

Рисунок 1.2  Схема Е3 лабораторного блока живлення 

 

Пропонований лабораторний імпульсний блок живлення (БЖ) зібраний 

на інтегральній мікросхемі L4960 фірми SGS-Thomson Microelectronics, що 

представляє собою регульований імпульсний стабілізатор напруги постійного 

струму, який забезпечує вихідний струм до 2,5 А при вихідній напрузі 5 ... 18 В.  

Призначений для забезпечення живлення електроприладу електричною 

енергією, при відповідності вимогам її параметрів: напруги, струму, і т. д. 

шляхом перетворення енергії інших джерел живлення. 

Мікросхема має вбудований захист від перевищення температури, 

перевантаження по струму і короткого замикання в ланцюзі навантаження. Цей 

блок призначений для живлення різних електронних пристроїв, які споживають 

потужність до 25 Вт. 

 Напруга 220 В через запобіжник FU1, контакти вимикача SA1 надходить на 

первинну обмотку понижувального трансформатора ТV1. 

Напруга вторинної обмотки трансформатора через запобіжник FU2 

надходить на мостовий випрямляч на діодах VD4-VD7 (FR607). Застосування 

таких діодів знижує втрати потужності на випрямлячі і, відповідно, нагрів його 

елементів, а також приблизно на 1 В збільшує випрямлену напругу. Запобіжник 

FU2 захищає трансформатор від перевантажень при несправності випрямляча, 

мікросхеми DA1, а також при "помилці" її системи захисту. 
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Варистор RU1 захищає мережевий трансформатор і діоди випрямляча 

від імпульсних перешкод і кидків напруги в мережі. Вихідна напруга 

регулюються змінним резистором R3 в інтервалі від 5 до 18 В ±10. Верхнє по 

схемі положення движка змінного резистора відповідає мінімальному значені 

вихідної напруги. 

Робоча частота мікросхеми DA1 - близько 95 кГц. Форма напруги на 

виході мікросхеми (висновок 7) прямокутна, шпаруватість імпульсів залежить 

від вихідної, вхідної напруг і струму навантаження. Діод VD1 захищає 

мікросхему від пошкоджень, наприклад, при різкому повороті движка змінного 

резистора R3 або підключенні до виходу БП зарядженого конденсатора великої 

ємності. При перевантаженні виходу стабілізатора, вбудований в мікросхему 

захист відключає вихідну напругу і приблизно через 0,5 с намагається 

запуститися знову. 

Дросель L2 - накопичувальний. Дволанковий фільтр С6-C8,L3C12-C16 

знижує пульсації вихідної стабілізованої напруги.  

Реле К1 включає живлення світлодіода HL1 при струмі навантаження 

більше 1 А. Це дозволяє оперативно відстежити підвищене енергоспоживання, 

наприклад. Струм відпускання контактів реле - близько 0,6 А. Котушка реле К1 

також входить до складу фільтра. 

На мікроамперметрі РА1, стабілітроні VD8 і резисторах R7, R8 

виконаний вольтметр, який вимірює вихідну напругу блоку живлення. 

Стабілітрон VD8 і резистор R8 забезпечують "розтяжку" шкали приладу РА1. 

Запобіжник FU3 розрахований на струм 0,75 А призначений для захисту вузлів 

малопотужного навантаження [1]. 

 

1.4 Проектування і розрахунок вузлів електричної принципової схеми 

пристрою 

 

1.4.1 Розрахунок електричних параметрів окремих каскадів.  

 

Схема електрична принципова RC-фільтра зображена на рисунку 1.3[2] 
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Рисунок 1.3- Схема електрична принципова RC-фільтра 

 

1. Вихідні дані для проведення розрахунку [2]: 

С = 0,22нФ 

Fc = 10кГц 

2. Розрахунок частоти зрізу проводиться за формулою: 

CRc
f

2

1
  ,                                          (1.1) 

де  С – ємність конденсатора; 

 R – опір резистора; 

Оскільки частота зрізу нам відомо, вона становить 10кГц, то розрахуємо 

тільки опір резистора. 

3. Розрахунок опору резистора: 

c
Cf

R
2

1
 ,                                       (1.2) 

де fc – частота зрізу, становить 10кГц. 

кОмR 4
10220014,32

1



  

Вибираємо резистор з опором 4,3 кОм та потужністю розсіювання 0,25Вт.  

R2 = 4,3кОм 

В даному пункті виконуємо електричний розрахунок випрямляючого 

моста на діодах VD4-VD7 та ємнісного згладжувального фільтра на 

конденсаторі С9 згідно [25]. Нижче приведена схеми електрична принципова 

випрямляча і ємнісного фільтра, який зображений на рисунку 1.4. 
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Рисунок 1.4 - Схема електрична принципова випрямляча та ємнісного 

фільтра 

Вихідні дані для розрахунку: 

  - Номінальна випрямлена напруга U0=30 В; 

  - Номінальний струм навантаження І0=0,35 А; 

                    - Коефіцієнт пульсацій Кп0=0,03  %; 

  - Номінальна напруга мережі U1=220 В; 

  - Номінальна частота мережі fм=50 Гц. 

Визначення основних параметрів і вибір діодів. 

 Uзв – зворотна напруга; 

 Іпр.сер – середнє значення прямого струму; 

 Іm – амплітуда імпульсного струму. 

В подальшому процесі розрахунку випрямлячів ці значення параметрів  

діодів уточнюються.  

Таблиця 1.1 – Формули для розрахунку мостового випрямляча 

A Uзв. Іпр.сер. Іm U2x I2 

íR

r
6,1  

 

2

0I
 00 5,35,0 IFI   

 

0BU  

2

0DI
 

  

          (1.2)             

1,5 20 30( )звU В    

 

 

02 5,14,1 UU x 

05,1 UU зв 
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        (1.3) 

.

0,25
0,2( )

2
пр серI А   

 

  (1.4) 

0,5 0,25 0,2( )mІ A    

 З довідника по напівпровідникових діодах вибираємо тип діода, 

параметри якого Uзв.max – максимально-допустима зворотна напруга і Iпр.сер.max 

– максимально-допустимий прямий середній струм трохи перевищують 

розраховані значення: Uзв.max > Uзв; Іпр.сер.max > Im. 

 За розрахованими значеннями параметрів вибираємо з довідника 

чотири діоди типу FR607. 

Розрахунок опору навантаження. 

 

   (1.5)   

  

                                                      
30

30( )
1

нR Ом   

 Визначення активного опору обмоток трансформатора. 

          Попередньо визначаємо потужність навантаження:  

 

   (1.6) 

0 30 1 30( )P Вт    

 Тоді активний опір обмоток трансформатора  ТРr   вибираємо в межах: 

       (0,05...0,08)ТР нr R                                          (1.7) 

 

                                      (1.8) 

Розрахунок прямого опору випрямляючого діода за наближеною 

формулою: 

                                                       
серпр

серпр

пр
І

U
r

.

.

3 
 ,                                                  (1.9) 

де – Uпр.сер. – середня пряма напруга діода, В (з довідника). 

 

0

0

I

U
RÍ 

000 IUP 

2

0
.

І
І серпр 

00,5mI I 

)(7,01007,0 ОмrТР 
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(1.10)                                      

 

Визначення активного опору фази випрямляча r за формулою: 

                                                           )(24,127,027,0 Омr                          (1.11) 

          Розрахунок параметрів вторинної обмотки трансформатора. 

 За формулами визначаємо значення напруги на вторинні обмотці 

трансформатора в режимі холостого ходу U2x і ефективне значення струму 

вторинної обмотки І2.: 

  

                              (1.12) 

 

2

1,5 30
32,1( )

1,4
xU В


   

 

   (1.13) 

 

        )(7,4
2

32,2
2 AI 


  

Визначення ємності конденсатора фільтра за формулою: 
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 де  С0 – ємність, мкФ; 

  r – опір, Ом . 
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 Розраховуємо робочу напругу: 
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Вибираємо тип конденсатора з довідника за параметрами С0 ном і Uроб. 

Вибрано електролітичні конденсатори типу b41828-50 В-4700 мкФ ±10% 

"Epcos". 

 

1.4.2 Розрахунок параметрів друкованого монтажу 

 

          Визначаємо мінімальну ширину  друкованого провідника, мм., по 

постійному струму для кіл живлення і заземлення [4]:           

              bmin1=
ti

I

доп *

max = мм

м
мм

A

A
5,1

035,0*48

5,2

2



    (1.3) 

де Іmax- допустима густина струму, який протікає в провідниках. 

Визначається із аналізу принципової схеми,  Імах = 2,5А ; 

 

    Ідоп – допустима густина струму, вибирається в залежності від методу 

виготовлення плати, jдоп = 48А/мм2, t – товщина провідника, 35мкм=0,035м 

Визначаємо мінімальну ширину провідника, мм., виходячи з 

допустимого падіння напруги на ньому: 

 

     bmin2=
t

lI

*  Uд

** max
= мм

мВ

мA
м

ммОм

9,0
035,0*1

6,0*5,2*
.

0175,0
2



                   (1.4) 

де: р = 0,0175 Ом*мм2/м – питомий об’ємний опір, 

L = 0,6м – довжина провідника, 

допU  = 1В – допустиме падіння напруги. 

Визначаємо номінальне значення діаметрів монтажних отворів d: 

                                 d = dE + |∆dн.в.| + r                                                 (1.5) 

де dE – максимальний діаметр виводу встановленого ЕРЕ (діаметр 

вивода ЕРЕ.) 

     ∆dH.B. – нижнє граничне відхилення від номінального діаметру 

монтажного отвору (0,1 для всіх) 
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r – різниця між мінімальним діаметром отвору і максимальним 

діаметром вивода ЕРЕ, її вибирають в межах 0,1…0,4мм. Розрахункові 

значення d зводяться до нормалізованого ряду отворів: 1,1; 1,3; 1,5 мм. 

dE1 = 0,9-для резисторів, конденсаторів, діодів, мікросхеми. 

dE2 =1,1- для конденсаторів електролітичних, реле та підпаювання 

провідників. 

d = dE2 + |∆dн.в.| + r = 0,9 + |+0,1| + 0,1 = 1, 1 мм 

d = dE2 + |∆dн.в.| + r = 1,1 + |+0,1| + 0,1 = 1, 3 мм 

 

Приймаємо такі стандартні діаметри отворів;1,1;1,3. 

Розраховуємо діаметр контактних площадок. 

  Dmin = D1min + 1,5hф + 0,03 

   (1.6) 

де       hф – товщина фольги;   

D1min – мінімальний ефективний діаметр площадки.   

                   







 pd

d
bD m 

2
2 max

min1                                  (1.7) 

де    bм – відстань від краю просвердленого отвору до краю контактної 

площадки. 

bм = 0,06 мм. 

де       δd  і δp - допуски на розташування отворів і контактних площадок; 

           δd =0,25мм, δp = 0,4мм; 

           dmax - максимальний діаметр просвердленого отвору, мм. 

 

                dmax=d+∆d+(0,1…0,15)                                  (1.8) 

де: ∆d - допуск на отвір. 

 

dmax1 =1,1+0,1+0,1=1,3 мм 

dmax2 =1,3+0,1+0,1=1,5 мм 

ммD 72,24,025,0
2

3,1
06,021min1 








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ммD 92,24,025,0
2

5,1
06,022min1 








  

Dmin1=2,92+1,5·0,035+0,03=2,8 мм 

Dmin2=2,92+1,5·0,035+0,03=3 мм 

 

Максимальний діаметр контактної площадки: 

Dmax=Dmin+(0,02…0,06) 

Dmax1=2,82 +0,02=2,82мм 

Dmax2=3 +0,02=3,02мм 

 

Визначаємо ширину провідників. Мінімальна ширина провідників для 

ДДП і зовнішніх шарів БДП, які виготовлені комбінованим методом: 

                                  03,05.1min1min  hфbb           (1.9) 

      де      b1min  - мінімальна ефективна ширина провідника, мм.  

                b1min =0,15 мм для плат 4- го класу точності. 

ммb 23,003,0035,0*5.115,0min   

Визначаємо мінімальну відстань між елементами провідного матеріалу. 

 

Мінімальна відстань між провідником і контактною площадкою: 
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де       Lo – відстань між центрами відповідних елементів; 

Мінімальна  відстань між двома контактними площадками: 

                   S2min = L0 – (Dmax + 2δp)           (1.11) 

S2min1 =2,5-(2,82+2·0,4)=-1,12мм 

S2min2 =2,5-(3,02+2·0,4)=-1,32мм 
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Мінімальна відстань між двома провідниками: 

         S3min=L0–(Dmax+2δ1)        (1.12) 

S3min1 =2,5-(2,82+2·0,05)=-0,42мм 

S3min2 =2,5-(3,02+2·0,05)=-0,62мм 

 

1.5  Вибір і обґрунтування компонентної бази 

 

С2, С6,С7, С9, С13, С15, С17- електролітичні конденсатори серії 

B41828 виробництва компанії EPCOS (нині TDK Corporation) є 

високонадійними компонентами, які широко використовуються в різних 

електронних пристроях та системах. Ці конденсатори відрізняються високою 

ємністю, що зазвичай варіюється від кількох мікрофарад (µF) до кількох 

тисяч мікрофарад. Номінальна напруга для даної серії коливається в межах 

від 10 В до 450 В, що дозволяє їх використовувати в різноманітних 

електричних схемах. Робочий температурний діапазон цих конденсаторів 

зазвичай становить від -40°C до +85°C або -40°C до +105°C, залежно від 

конкретної моделі. Це робить їх придатними для використання в умовах 

різних температурних режимів. 

Термін служби конденсаторів серії B41828 часто становить 2000-5000 

годин при максимально допустимій температурі і номінальній напрузі, що 

забезпечує їх довговічність у більшості застосувань. Як і всі електролітичні 

конденсатори, вони мають полярність, тобто повинні бути підключені у схемі 

з дотриманням правильного напрямку, оскільки неправильне підключення 

може призвести до виходу конденсатора з ладу. 

Ці конденсатори також мають низький еквівалентний серійний опір 

(ESR), що є важливим параметром для зменшення втрат потужності і 

теплових втрат, а також для поліпшення ефективності фільтрації в різних 

електронних пристроях. Загалом, електролітичні конденсатори серії B41828 є 

надійним вибором для різних електронних застосувань завдяки своїм 

технічним характеристикам та високій надійності [5]. 
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Рисунок 1.5- Габаритні розміри конденсатора електролітичного 

b41828"Epcos" 

R1-R2, R3-R8- резистори постійні серії MFP виробництва компанії 

Yageo є популярними компонентами, які широко використовуються в 

електронних схемах завдяки своїм відмінним технічним характеристикам та 

надійності. Резистори MFP виготовлені з металлоплівкового матеріалу, що 

забезпечує високу стабільність та точність опору. Металлоплівкові резистори 

зазвичай мають нижчий рівень шуму і кращу стабільність температури в 

порівнянні з іншими типами резисторів. Номінальна потужність для 

резисторів цієї серії варіюється від 1/8 Вт до 1 Вт, що дозволяє 

використовувати їх у різноманітних електронних застосуваннях. Опір таких 

резисторів може бути в широкому діапазоні – від кількох ом до кількох 

мегом, що робить їх придатними для багатьох різних схем. 

Ці резистори мають низький температурний коефіцієнт опору, що 

забезпечує стабільність параметрів при зміні температури навколишнього 

середовища. Допуск на опір зазвичай становить ±1%, що гарантує високу 

точність роботи. Крім того, резистори MFP мають відмінні показники 

надійності та довговічності, що робить їх надійними компонентами для 

тривалого використання в різних умовах. 

Компактні розміри цих резисторів дозволяють їх використовувати в 

мініатюрних електронних пристроях, зберігаючи при цьому необхідні 

електричні характеристики. Резистори серії MFP від Yageo також 

характеризуються стійкістю до механічних навантажень та вібрацій, що є 

важливим у промислових та автомобільних застосуваннях. Загалом, постійні 
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резистори серії MFP від Yageo є високоякісними та надійними 

компонентами, які забезпечують стабільну роботу електронних схем у різних 

умовах експлуатації [6] 

 

 

Рисунок 1.6- Габаритні розміри резисторів постійних 

 

C1,C3-С5, С8, С10-С12, С14, С16- керамічні конденсатори серії 

B37979, вироблені компанією EPCOS (нині TDK Corporation), є 

високоякісними пасивними компонентами, які знаходять широке 

застосування в різноманітних електронних пристроях та системах. Ці 

конденсатори виготовлені з багатошарової кераміки, що забезпечує високу 

надійність і стабільність параметрів. Основні характеристики включають 

широкий діапазон номінальної ємності, що зазвичай варіюється від кількох 

пікофарад (pF) до декількох мікрофарад (µF), та номінальну напругу, яка 

може досягати від 16 В до 100 В і більше. 

Однією з ключових особливостей серії B37979 є низький еквівалентний 

серійний опір (ESR) та низька індуктивність, що робить ці конденсатори 

ідеальними для використання в високочастотних схемах і додатках, що 

вимагають високої ефективності. Вони також мають відмінні температурні 

характеристики, з діапазоном робочих температур від -55°C до +125°C, що 

забезпечує їх стабільну роботу в різних умовах навколишнього середовища. 

Керамічні конденсатори серії B37979 мають низький рівень втрат та 

високу стабільність ємності, що особливо важливо для використання в 

точних схемах, таких як осцилятори, фільтри та схемах перетворення 

живлення. Компактні розміри і можливість поверхневого монтажу роблять їх 

зручними для використання в сучасних компактних електронних пристроях. 
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Завдяки високій надійності, стійкості до вібрацій і ударів, ці 

конденсатори також широко використовуються в автомобільній електроніці 

та промислових додатках. Керамічні конденсатори серії B37979 від EPCOS 

(TDK) є чудовим вибором для будь-яких застосувань, де потрібні надійні, 

стабільні та високопродуктивні конденсатори [7]. 

 

Рисунок 1.7- Габаритні розміри конденсатора b37979 "Epcos" 

 

SA1- перемикач PSM7-1-0 є електромеханічним компонентом, який 

використовується для комутації електричних ланцюгів. Цей перемикач 

належить до класу поворотних перемикачів, що означає, що комутація 

відбувається шляхом повороту ручки або важеля. Він зазвичай має одну або 

кілька позицій, дозволяючи вибирати різні ланцюги або режими роботи 

пристрою.  

Конструкція перемикача забезпечує надійний механічний контакт і 

високу стійкість до зносу, що робить його придатним для тривалого 

використання. PSM7-1-0 зазвичай виготовляється з високоякісних 

матеріалів, які забезпечують його надійність і довговічність навіть в умовах 

інтенсивної експлуатації.  

Також цей перемикач може мати різні варіанти монтажу, включаючи 

поверхневий монтаж або монтаж в отвори, що робить його зручним для 

використання в різних типах електронних пристроїв і обладнання.  
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Перемикачі цієї серії часто використовуються в промисловій 

автоматизації, побутовій техніці, комунікаційних пристроях та інших 

областях, де необхідна надійна комутація електричних ланцюгів [8]. 

 

Рисунок  1.8- Габаритні розміри перемикача 

 

FU1-FU3- запобіжник ZH214-015 на 3 А є захисним електричним 

компонентом, призначеним для захисту електричних ланцюгів від 

перевищення струму. Він призначений для використання в системах змінного 

або постійного струму з номінальною напругою, що відповідає 

характеристикам запобіжника.  

Запобіжник ZH214-015 має рейтинг току 3 А, що означає, що він буде 

відключати ланцюг при перевищенні цього значення. Він може мати різні 

форми та розміри, залежно від виробника і конкретної моделі, але його 

основна функція полягає в тому, щоб у разі перевищення струму запобігти 

пошкодженню електричного обладнання або системи в цілому. Такі 

запобіжники часто використовуються в електричних панелях, електронних 

пристроях та інших системах, де необхідний захист від короткого замикання 

або перевантаження [9] 

 

Рисунок 1.9- Габаритні розміри запобіжника   
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HL1-HL2 -світлодіод типу L-1503GT є електронним полупровідниковим 

пристроєм, який випромінює зелене світло. Він може мати різні форми та 

розміри, зазвичай представлений у стандартному круглому або прямокутному 

корпусі. Світлодіоди цього типу відомі своєю високою яскравістю, що робить 

їх видимими навіть в яскравому освітленні. Цей світлодіод може бути 

використаний для освітлення, сигналізації та декоративних цілей [10]. 

 

 

Рисунок 1.10 – Габаритні розміри світлодіода L-1503GT -HL   

 

Резистори R3 змінні, з рейки 16K1, характеризуються лінійною 

залежністю та доступною вартістю. Потенціометр 16K1 має корпус з вуглецю 

та металевий вал. Вони застосовуються в електричних ланцюгах для 

вимірювання та регулювання напруги та ЕРС [11]. 

 

Рисунок 1.11 – Габаритні розміри змінного резистора 16K1 
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Мікросхема L4960-DA1 використовується як лінійний комутаційний 

регулятор. Вона приймає високі вхідні напруги і може постачати вихідні 

струми до 4A з високою частотою перемикання. 

 

Таблиця 1.2  Мікросхема L4960 [12] 

Позиційне позначення DA1 

Назва компонента Мікросхема L4960 

Виробник ST Microelectronics 

Параметри та характеристики 

Каналів, шт 1 

Вхід: VIN (хв.), В 9 

Вхід: VIN (макс.), В 46 

Вихід: VOUT (хв.), В 5.1 

Вихід: VOUT (макс.), В 40 

Вихід: IOUT (макс.), А 2.5 

TA, ° С від -40 до 125 

IQ (тип.), МкА 30000 

 

Рисунок 1.12 – Зовнішній вигляд мікросхеми L4960 

 

Реле К1-RT424110 - це електромеханічний пристрій, призначений для 

керування електричними ланцюгами. Воно включає в себе електромагнітну 

котушку, що вмикає або вимикає контакти залежно від наявності 

електричного струму. Основні характеристики реле К1-RT424110 полягають 

у наступному: тип реле - електромеханічний, напруга роботи - зазвичай 110 

В, тип контактів - різні, залежно від потреби, а навантаження - різноманітне, 

від ламп до моторів та інших електричних пристроїв. Воно є невід'ємною 

частиною багатьох електричних систем і забезпечує ефективне управління 

електричним обладнанням. 
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Таблиця 1.3  Реле К1- RT424110 [13] 

Позиційне позначення К1 

Назва компонента Реле RT424110 

Виробник "TE Connectivity" 

Параметри та характеристики 

Струм живлення обмотки постійний 

Класифікація реле за початковим станом  моно стабільний 

поляризація нейтральне 

Кількість обмоток 1 

Номінальна робоча напруга, В 24 

Максимальна комутована постійна напруга, В 30 

Максимальний комутований струм, А 3 

Максимальна комутована змінна напруга (cosf * 1), В 240 

 

 

Рисунок 1.13 – Габаритні розміри реле RT424110  

 

  Дросель НСНК-007 є електронним компонентом, використовується 

для обмеження або фільтрації струму в електричних ланцюгах.  

Цей дросель може мати різні параметри, такі як індуктивність, опір та 

максимальний струм.  

Він зазвичай використовується у схемах живлення для стабілізації 

напруги або обмеження перенапруги. Дросель НСНК-007 може бути 

використаний у різних галузях, таких як електроніка, електротехніка та 

автомобільна промисловість, для підтримання ефективної роботи 

електричних систем. 
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Таблиця 1.4  Дросель НСНК-007-150mH  [14] 

Позиційне позначення L2,L3 

Назва компонента Дросель НСНК-007-150mH   

Виробник Epcos 

Параметри та характеристики 

Ефективність передачі потужності 75% 

Індуктивність 20мкГн, 150мкГн 

Температура зберігання -20 ° C-85 ° C 

Робоча температура -20 ° C-105 ° C 

 

 

Рисунок 1.14 – Габаритні розміри дроселя НСНК-007-150mH   

 

РА1-Амперметр М42300 призначений для вимірювання постійного 

струму в діапазоні від 5 мА до 15 кА. Це аналоговий стрілочний прилад, який 

може підключатися безпосередньо або через додаткові опори-шунти залежно 

від вимірюваних величин струму. Для вимірювання струмів, що 

перевищують зазначені межі, використовуються зовнішні шунти, які 

постачаються окремо. 

Основні технічні характеристики амперметра М42300 включають 

діапазон вимірюваних струмів від 10 мА до 20 А при безпосередньому 

підключенні та від 5 мА до 15 кА з використанням шунтів. Точність 

вимірювання становить 1,5%. Габаритні розміри приладу складають 

80×80×49 мм, діаметр вирізу в щиті — 77,5 мм. Середній термін служби 

амперметра М42300 становить 12 років, з середнім напрацюванням до 

відмови — 92,250 годин. Ступінь захисту по лицьовій панелі може бути IP50 

або IP54, для струмоведучих частин — IP00. 
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Корпус амперметра виготовлений з високоякісного пластику, що 

забезпечує його використання в жорстких умовах експлуатації. Прилад може 

витримувати перевантаження струмом чи напругою до 120% від верхньої 

межі діапазону вимірювань протягом 2 годин. 

Для підтримки точності показань амперметр М42300 потребує 

періодичної повірки та калібрування, яке проводиться кожні 1-5 років 

залежно від класу точності. Під час експлуатації важливо дотримуватися 

полярності підключення та уникати механічних навантажень і потрапляння 

вологи всередину приладу[15]. 

 

 

Рисунок 1.15 – Габаритні розміри амперметра 

RK1- терморезистор NB-PTCO-160 - електронний компонент, що 

змінює свій опір в залежності від температури навколишнього середовища. 

Цей тип терморезистора відноситься до позитивних температурних 

коефіцієнтів опору (PTC), що означає, що його опір збільшується зі 

зростанням температури. NB-PTCO-160 призначений для роботи при високих 

температурах, оскільки його діапазон температур може досягати значень до 

160°C. 

Такі терморезистори часто використовуються для захисту електроніки 

від перегріву, контролю температури або в системах автоматичного 

регулювання. їх також можна зустріти в електронних термостатах, системах 

охолодження, термопринтерах та інших пристроях, де важливо вимірювати 

або контролювати температуру. Вони забезпечують стабільну та надійну 

роботу в різних умовах експлуатації [16]. 
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Рисунок 1.16– Габаритні розміри терморезистора NB-PTCO-160 

 

Силові трансформатори ТС-60-TV1, використовувані для живлення 

різноманітної побутової радіоелектронної апаратури, мають номінальну 

потужність 60 ват. Сердечники цих трансформаторів можуть бути 

броньованими шаландами або стрижневими пластинами, виготовленими зі 

сталевої стрічки марки Е-320 з перетином 22х32. Також зустрічаються 

стрижневі трансформатори ТС-60 з перетином сердечника 16х32, а також 

броньовані трансформатори з штампованими Ш-образними пластинами УШ. 

 

Рисунок 1.17 – Зовнішній вигляд трансформатора 

 

Діод FR607 є швидкісним діодом, який часто використовується для 

випрямлення змінного струму. Його основні характеристики включають 

високу швидкість комутації і велику обертову напругу. Цей діод може 

працювати в широкому діапазоні температур і володіє високою надійністю. 

Він застосовується у багатьох електронних схемах, включаючи випрямлення, 

блоки живлення та інші. 
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Таблиця 1.5  Діод FR607 [17] 

Позиційне позначення VD1, VD4,VD7 

Назва компонента Діод FR607 

Виробник Diotec 

Параметри та характеристики 

Корпус r-6 

Робоча температура, С -65 ... 150 

Загальна ємність Сд, пФ 50 

Максимальний час зворотного відновлення, мкс 0.5 

Максимальний прямий (випрямлений за 

напівперіод) струм, А 

6 

матеріал кремній 

 

Рисунок 1.18 – Габаритні розміри діода FR607 

 

Однією з ключових переваг даного типу діодів є низьке падіння напруги, 

яке зазвичай становить від 0,2 до 0,4 вольта. Ця характеристика досягається 

завдяки тому, що електричний струм у діоді Шотткі формується основними 

носіями заряду, відмінно від традиційних діодів. У діоді Шотткі замість p-n 

переходу використовується перехід метал-напівпровідник, що забезпечує 

швидкий час перемикання. 

Діоди Шотткі SR306-B 60V 3A – VD2,VD3 часто використовуються як 

мостовий випрямляч. Застосування таких діодів дозволяє зменшити втрати 

потужності на випрямлячі. 

Проте, при використанні діода Шотткі слід уникати навіть 

короткочасного перевищення напруги понад вказане значення, щоб уникнути 

пошкодження діода. 

 

 



 

 

 
Змн. Арк. № докум. Підпис Дата 

Арк. 

 ГЮЮ 3.22.053.001 ПЗ 
 
 

Таблиця 1.6  Діод шотки SR306-B [18] 

Позиційне позначення VD2,VD3 

Назва компонента Діод шотки SR306-B 

Виробник МСС 

Параметри та характеристики 

Максимальна постійна зворотна напруга, В 60 

Максимальний прямий (випрямлений за 

напівперіод) струм, А 

3 

корпус do201ad 

Максимальна пряму напругу, В 0.75 

Максимально допустимий прямий імпульсний 

струм, А 

100 

Робоча температура, С -65 ... 125 

 

Рисунок 1.19 – Габаритні розміри діод шотки SR306-B 

 

Стабілітрон 1N4729A - це напівпровідниковий прилад, який 

використовується для стабілізації напруги в електричних ланцюгах. Його 

основна функція полягає в тому, щоб забезпечувати постійний рівень 

напруги незалежно від змін зовнішніх умов, таких як зміна температури чи 

коливання напруги в мережі живлення. 

Стабілітрон 1N4729A має напругу стабілізації 3.3 В. Він забезпечує 

стабільну напругу на своїх затримних клемах при великому діапазоні 

температур та струмів. Цей стабілітрон застосовується в різних електронних 

схемах, де потрібна точна стабілізація напруги, таких як джерела живлення, 

регулятори напруги, датчики та інші пристрої. Він допомагає забезпечити 

стабільну роботу електроніки та захистити її від можливих перенапруг та 

несправностей в мережі живлення. 
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Таблиця 1.7  Стабілітрон 1N4729A [19] 

Позиційне позначення VD8 

Назва компонента Діод шотки SR306-B 

Виробник NXP 

Параметри та характеристики 

Потужність розсіювання, Вт 1 

Мінімальна напруга стабілізації, В 3.42 

Статичний опір Rст., Ом 10 

Робоча температура, С -55 ... 200 

Корпус do41 

Номінальна напруга стабілізації, В 3,6 

 

Рисунок 1.20 – Габаритні розміри 1N4729A "NXP" 

 

Рисунок 1.21 – Габаритні розміри індуктивність la10as2221r5r2b 

Мережеві фільтри загального призначення серії la10as2221r5r2b-L1, 

виготовлені компанією Murata, спрямовані на приглушення перешкод у 

однофазних мережах змінного струму. Їх відзначають компактні розміри і 

легка вага. Діапазон робочих температур для фільтрів цієї серії становить від -

25 °C до +60 °C. Розігрів обмоток не перевищує 60 °C при максимальному 

робочому струмі. Робоча напруга фільтрів становить 250 Вольт. 
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Таблиця 1.8  Індуктивність Рla10as2221r5r2b [20] 

Позиційне позначення L1 

Назва компонента Індуктивність Рla10as2221r5r2b 

Виробник Murata 

Параметри та характеристики 

Тип pla 

виконання здвоєний 

Номінальний струм, А 1.5 

Номінальна напруга, В 300 

Індуктивність обмотки, мГн 2.2 
 

1.6  Компоновка друкованого вузла пристрою 

 

При компонуванні приладу, який проектується або вже входить до 

складу вузла, важливо дотримуватися кількох основних правил: 

1. Функціональність: Прилад повинен виконувати свою функцію 

ефективно та безперебійно. Компонування повинно забезпечувати вільний 

доступ до всіх необхідних елементів для їх належної роботи. 

2. Ергономіка: Розташування елементів приладу має бути зручним 

для користувача. Враховуйте, що легкість у використанні і навіть 

відновлення ремонтів може стати ключем до успіху вашого проекту. 

3. Безпека: Забезпечте, щоб компоненти були розташовані таким 

чином, щоб уникнути небезпечних ситуацій, таких як коротке замикання або 

перегрівання. 

4. Монтаж і обслуговування: Важливо враховувати можливість 

монтажу та обслуговування приладу. Компоненти повинні бути легко 

доступні для заміни, налаштування та ремонту. 

5. Естетика: Хоча це не завжди першочерговий аспект, привернення 

уваги до зовнішнього вигляду приладу може бути важливим з комерційної 

точки зору або для поліпшення користувацького досвіду. 

6. Мінімізація збоїв: Розмістіть критичні компоненти таким чином, 

щоб мінімізувати вплив взаємних впливів і збоїв. Наприклад, уникайте 

розташування високовольтних і низьковольтних частин поруч, щоб уникнути 

перешкод. 
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7. Розумний розподіл простору: Використовуйте простір приладу 

ефективно, уникайте перевантаження областей займання та забезпечте 

достатній простір для вентиляції та охолодження. 

Конструкція друкованого вузла лабораторного блока живлення 

передбачає вміщення всіх необхідних елементів і деталей на печатну плату з 

метою забезпечення ефективної та надійної роботи пристрою. Для 

досягнення цієї мети важливо врахувати кілька аспектів компоновки: 

 

Розміщення компонентів: Кожен елемент, включаючи резистори, 

конденсатори, транзистори та інші, повинен бути розміщений на платі таким 

чином, щоб забезпечити мінімальні взаємодії між ними та максимальну 

доступність для монтажу та обслуговування. 

Маршрутизація доріжок: Доріжки, що з'єднують компоненти, повинні 

бути розташовані таким чином, щоб мінімізувати перешкоди та перетини, що 

можуть виникнути під час передачі сигналів. Вони також повинні бути 

достатньо широкими та мається на увазі, що тракти живлення потребують 

більшої ширини для підвищення потужності та зменшення втрат енергії. 

Розташування зон живлення та землі: Зони живлення (провідники 

живлення) та землі (заземлення) повинні бути розташовані поруч одна з 

одною для забезпечення коротких шляхів передачі сигналів і мінімізації 

шуму. 

Розташування отворів для кріплення: Друкована плата повинна мати 

отвори для кріплення на шасі або корпусі пристрою, щоб забезпечити його 

міцність та стабільність. 

Теплові відповідальні компоненти: Компоненти, які можуть 

нагріватися під час роботи, такі як потужні транзистори чи інтегральні 

мікросхеми, повинні бути розташовані таким чином, щоб забезпечити 

вільний доступ до них для вентиляції та розподілу тепла. 

Місце для підключення внутрішніх та зовнішніх з'єднань: Друкована 

плата повинна містити місця для підключення внутрішніх та зовнішніх 

з'єднань, таких як роз'єми живлення, роз'єми для підключення зовнішніх 
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пристроїв та інші. 

 

Компоновка друкованого вузла лабораторного блока живлення вимагає 

уважного планування та розгляду всіх вказаних аспектів для забезпечення 

ефективної та надійної роботи пристрою [21]. 

Звичайна компоновка друкованого вузла пристрою передбачає 

розташування електронних компонентів, таких як мікрочіпи, резистори, 

конденсатори та інші, на поверхні спеціальної плати. Ця плата зазвичай 

виготовляється з ізольованого матеріалу, наприклад, фібергласу або 

полімерного композиту, на яку наноситься мідний шар для створення 

електричних з'єднань. Компоненти зазвичай припаюються або кріпляться до 

плати за допомогою паяльних з'єднань або спеціальних кріплень. 

Після розташування компонентів на платі проводять монтажні роботи, 

такі як паяння або напівавтоматичне нанесення паяльної пасти для паяння 

поверхневих монтажних компонентів. Після цього плата може піддаватися 

додатковим процесам, таким як випробування та інспекція для перевірки 

якості монтажу. 

Крім того, компоненти можуть бути розташовані на платі згідно з 

електричними схемами та функціональними вимогами пристрою. Важливо 

також враховувати теплові властивості компонентів та їхнє розташування для 

забезпечення ефективного розподілу тепла та підтримки нормальної роботи 

пристрою в умовах використання. 
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1.7 Висновок до розділу 1  

 

Після аналізу технічного завдання виявлено основні вимоги до 

пристрою, зокрема щодо його функціональності, продуктивності та 

надійності. Структурний аналіз виробу надав загальне уявлення про логічну 

організацію пристрою та взаємозв'язки між його основними блоками. Опис 

принципу роботи електричної принципової схеми та її аналіз виявили 

ключові аспекти функціонування пристрою і можливі проблеми чи недоліки. 

Під час проектування і розрахунків вузлів електричної принципової 

схеми були враховані електричні параметри окремих каскадів і параметри 

друкованого монтажу для забезпечення високої ефективності та надійності 

пристрою. Вибір і обґрунтування компонентної бази проводився з огляду на 

вимоги до продукту, враховуючи параметри компонентів, їхню надійність, 

вартість та наявність на ринку. 

Компоновка друкованого вузла пристрою була розроблена з метою 

оптимізації розташування компонентів на платі з урахуванням електричних 

та теплових характеристик, щоб забезпечити ефективну роботу пристрою в 

умовах експлуатації. 
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2 Спеціальна частина 

 

2.1 Обгрунтування використання та вибору САПР для проектування     

 

Створення документації за допомогою систем автоматизованого 

проектування можна розглянути як процес, який складається з окремих 

етапів, згідно з алгоритмом, представленим на рисунку 2.1. На цьому 

рисунку зображено основні кроки створення необхідної документації. 

 

Рисунок 2.1- Алгоритм створення документації 
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Створення конструкції друкованої плати можна розглянути як процес, 

який складається з декількох етапів, згідно з алгоритмом, представленим на 

рисунку 2.2. Початковим кроком у роботі з Altium Designer є створення 

робочого простору, в якому створюються проекти виробів. Пустий (останній) 

робочий простір створюється (відкривається) при запуску Altium Designer, 

також можна створити пустий робочий простір, вибравши команду 

File→New→Design Workspace. У робочому просторі створюється проект 

PCB Project – проект плати, клікнувши ЛКМ (лівою кнопкою миші) на кнопці 

Project та вибравши команду Add New Project→PCB Project.  

 

Рисунок 2.2 – Алгоритм створення малюнку друкованої плати 

 

Спочатку створюється бібліотека символів (УГП ЕРЕ). Для нової 

бібліотеки необхідно виконати команду: File>New>Library>Schematic Library. 

Нова бібліотека зберігається командою File>Save. Панель для роботи з 

бібліотекою символів відкривається кнопкою SCH>SCH Library у нижній 

правій частині вікна і розміщується зліва від робочої області. 

Пізніше створюється УГП всіх використовуваних ЕРЕ. Наступний крок 

- створення бібліотеки топологічних посадочних місць ТПМ (Footprint). 

Посадочні місця групують набір контактних площадок на платі і контур 
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компонента. Щоб створити нове посадочне місце, створюють нову 

бібліотеку, для чого виконується File>New>Library>PCB Library. 

У розпорядженні дві бібліотеки: у першій зберігаються символи, а в 

другій – посадочні місця. Останній крок, щоб використовувати 

повнофункціональний компонент на схемі і платі, – установка посилання для 

компонента на модель посадочного місця. 

Даний метод може бути реалізований різними способами, і є декілька 

варіантів використання бібліотек. В даній роботі використовується підхід, 

який часто використовують розробники, а саме – зберігання всіх компонентів 

і моделей у вигляді інтегрованих бібліотек. 

 

Рисунок 2.3 – Алгоритм створення бібліотеки елементів в Altium 

Designer 

 

Після створення двох бібліотек необхідно створити інтегровану 

бібліотеку, виконавши команду Files→New→Project→Integrated Library. Далі 

бібліотеки умовних графічних зображень і посадочних місць перетягуються у 

папку інтегрованої бібліотеки на панелі Projects. Потім відкривається 

бібліотека умовних графічних зображень, і на панелі SCH Library 

вибирається УГП для якого необхідно додати посадочне місце. В вікні Model 

натискається кнопка ADD, вибирається тип Footprint і натискається кнопка 

ОК. Відкривається вікно PCB Model, де натискається кнопка Browse для 

вибору бібліотеки. В вікні Browse Libraries обирається необхідне посадочне 

місце для даного УГП і натискається ОК. Цю процедуру необхідно 

повторити для всіх УГП. Після цього здійснюється компіляція бібліотеки 
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командою Project→Compile Integrated Library, після чого створюється 

інтегрована бібліотека. 

Після створення інтегрованої бібліотеки створюється електрична 

принципова схема, на основі якої буде створено малюнок друкованої плати. 

Командою File→New→Schematic створюється документ електричної плати. 

Далі здійснюється початкове налаштування документа командою 

Design→Document Options. 

Під час цього відкривається вікно Document Options, в якому на вкладці 

Units обирається Use Metric Unit System – використання метричної системи 

координат і Metric unit used – Millimeters. На вкладці Sheet Options у полях 

Grids Snap і Visual вводиться крок 2.5 мм, а в полі Grid Range – 1 мм. Після 

цього початкове налаштування завершується, і можна приступати до 

побудови електричної принципової схеми. 

Початок побудови електричної схеми полягає у початковому 

розміщенні УГП на листку. Для цього відкривається вкладка Libraries, і 

вибирається необхідна інтегрована бібліотека зі списку УГП, які міститься в 

ній. Після розміщення УГП на листку їх треба з'єднати лініями електричного 

зв'язку, що виконується за допомогою команди Place→Wire. Натиснувши 

кнопку Tab, можна змінити колір і товщину лінії. Для проведення 

електричного зв'язку курсор ведеться до виводу УГП, доки на кінці виводу не 

з'явиться червоний хрестик. 
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Рисунок 2.4 – Створення електричної принципової схеми в Altium 

Designer 

Після виконання вищезазначених кроків, користувач повинен підвести 

курсор до виводу, з яким має відбутися електричне з'єднання. Після появи 

червоного хрестика на виводі, потрібно натиснути ліву кнопку миші, і 

з'єднання буде побудовано.  

Для розміщення значку корпусу слід виконати команду "Place→Power 

Pot". Після цього з'явиться знак корпусу, але поруч з ним буде напис "VCC", 

що означає підключення до шини живлення. Для зміни на шину корпусу 

треба натиснути клавішу "Tab" і в полі "Net" ввести "GND". Для зменшення 

кількості проведених ліній, особливо якщо вона перетинає весь аркуш, 

можна використовувати присвоєння лініям імен. При цьому треба провести 

короткий відрізок від кожного виводу елементів, які маємо з'єднати, і 

виконати команду "Place→Net Label". Потрібно задати назву шини, для цього 

натисніть кнопку "Tab", введіть назву шини в поле "Net", а потім натисніть 

"OK". Потім підведіть до лінії, яку маємо об'єднати з іншими, і коли на лінії 

з'явиться червоний хрестик, натисніть ліву кнопку миші. Повторіть цю дію 

для кожної лінії. Після проведення всіх з'єднань можна розмістити остаточно 
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елементи для кращого читання схеми і рівномірного заповнення простору 

аркуша. Для цього утримуючи натиснутою клавішу "Ctrl", клацніть лівою 

кнопкою миші та перетягніть елемент на потрібне місце, при цьому 

електричний зв'язок збережеться і змінить своє положення пропорційно до 

зміни положення елемента.  

Після побудови електричної схеми необхідно здійснити автоматичну 

нумерацію елементів. Для цього виконайте команду "Tools→Annotate 

Shematics". Після цього відкриється вікно "Annotate", де потрібно встановити 

параметр автоматичної нумерації "Down Then Across" в полі "Order of 

Processing". Після цього натисніть кнопку "Update Changes List", а в вікні 

"Proposed Change List" буде показана нова нумерація.  

Для її збереження натисніть кнопку "Accept Changes", а потім 

відкриється вікно "Engineering Change Order", де послідовно натисніть 

кнопки "Validate Changes", "Execute Changes" і "Close".  

 

Після цих дій в усій схемі буде встановлена автоматична нумерація. 

Компіляція проекта розпочинається командою "Project>Compile PCB Project". 

Після завершення операції, яка включає перевірку відповідності заданим 

правилам та створення звіту про коректність розробки, вікно "Messages" не 

містить помилок, що свідчить про правильність схеми. Проект стає готовим 

для передачі інформації на друковану плату. 

Для створення малюнку друкованої плати потрібно спочатку створити 

файл плати за допомогою команди "File→New→PCB". Після цього 

виконується початкове налаштування документу через команду 

"Design→Board Options", де обирається метрична система в полі "Unit" і 

після цього натискання кнопки "OK". Затим, натискаючи кнопку "G" з 

контекстного меню, обирається необхідний крок сітки для малюнку.  

Щоб передати інформацію про плату з електричної принципової схеми, 

виконується команда "Design→Update PCB", після чого відкривається вікно 

"Engineering Change Order", де потрібно послідовно натискати кнопки 

"Validate Changes", "Execute Changes" і "Close".  
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Після цієї операції в документі плати з'являються посадочні місця всіх 

елементів і лінії зв'язку між ними. Далі необхідно розмістити всі елементи в 

потрібних місцях плати і задати параметри провідників, відстаней між ними і 

контактними площадками через команду "Design→Rules", викликавши вікно 

"PCB Rules and Constraints Editor".  

Після цього налаштування правил трасування завершено. Для 

автотрасування необхідно виконати команду "Auto Route→All", обрати 

необхідний тип плати і натиснути "Rout All". 

Після закінчення автотрасування слід перевірити малюнок друкованої 

плати на наявність неефективно проведених провідників і вручну 

оптимізувати їх. Для імпорту малюнку друкованої плати необхідно зберегти 

плату у форматі PDF. 

 

Рисунок 2.5-Плата друкована виготовлена в Altium Designer 
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Рисунок. 2.6 - Створення електричної принципової схеми  

 

 

 

2.2 Опис створення 3D  плати виробу  

3D  модель  друкованої  плати зображена  на  рисунку  2.7 та рисунку 2.8 

[24]. 

 

Рисунок 2.7-3D вигляд плати друкованої з сторони елементів 

Вигляд плати друкованої з вигляду пайки і елементів. Плата 

одностороння та виготовлена хімічним методом. 
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Рисунок 2.8-3D вигляд плати друкованої з сторони пайки 

2.3 Висновок до розділу 2 

 

Обгрунтування використання та вибору системи автоматизованого 

проектування (САПР) для розробки є ключовим етапом у процесі 

проектування даного пристрою. САПР дозволяє оптимізувати та прискорити 

процес проектування, забезпечуючи високу точність і ефективність роботи 

інженерного персоналу. 

Створення 3D моделі плати виробу є важливим етапом у проектуванні, 

оскільки це дозволяє візуалізувати фізичну структуру пристрою та його 

компонентів, ідентифікувати можливі конструктивні проблеми та вирішувати 

їх на ранніх етапах розробки. Застосування САПР для створення 3D моделі 

плати виробу дозволяє інженерам реалізувати кращий контроль над всіма 

аспектами дизайну, включаючи розташування компонентів, урахування 

електричних та теплових характеристик, а також взаємодію з корпусом 

пристрою. 

Таким чином, використання САПР для створення 3D моделі плати 

виробу є обґрунтованим стратегічним рішенням, яке дозволяє забезпечити 
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високу якість та ефективність проектування, а також відповідати вимогам 

сучасного ринку електроніки. 

 



 

Змн. Арк. № докум. Підпис Дата 

Арк. 

 
 

ГЮЮ 3.22.053.001 ПЗ 
 
 

3. Безпека життєдіяльності, охорона праці  

 

3.1 Класифікація небезпек за джерелом походження  [29] 

 

Джерелами (носіями) небезпек є природні процеси та явища, елементи 

техногенного середовища, людські дії, що криють у собі загрозу небезпеки. 

Небезпеки існують у просторі й часі та реалізуються у вигляді потоків 

енергії, речовини та інформації. Небезпеки не діють вибірково, вони 

впливають на все матеріальне довкілля. Причинами, через які окремі об'єкти 

не страждають від певних небезпек або ж одні страждають більше, а інші 

менше, є властивості самих об'єктів (приклад: куля вбиває тварину або 

людину, але не пробиває кам’яну стіну). 

Номенклатура, тобто перелік можливих небезпек, налічує понад 150 

найменувань і при цьому не вважається повною. З метою аналізу, 

узагальнення та розробки заходів щодо запобігання негативним наслідкам 

існує необхідність класифікації небезпек, джерел, що породжують їх, та 

чинників (факторів), які безпосередньо призводять до негативного впливу на 

людину. 

Залежно від конкретних потреб існують різні системи класифікації — 

за джерелом походження, локалізацією, наслідками, збитками, сферою 

прояву тощо. Найбільш вдалою є класифікація небезпек життєдіяльності 

людства за джерелами походження, згідно з якою всі небезпеки поділяються 

на чотири групи: природні, техногенні, соціально-політичні та 

комбіновані. До четвертої групи віднесено три підгрупи: природно-

техногенні, природно-соціальні та соціально-техногенні небезпеки, 

джерелами яких є комбінація різних елементів життєвого середовища. 

Природні джерела небезпеки — це природні об'єкти, явища природи та 

стихійні лиха, які становлять загрозу для життя чи здоров'я 

людини (землетруси, зсуви, селі, вулкани, повені, снігові лавини, шторми, 

урагани, зливи, град, тумани, ожеледі, блискавки, астероїди, сонячне та 
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космічне випромінювання, небезпечні рослини, тварини, риби, комахи, 

грибки, бактерії, віруси, заразні хвороби тварин та рослин). 

Техногенні джерела небезпеки — це передусім небезпеки, пов'язані з 

використанням електричної енергії, хімічних речовин, різних видів 

випромінювання (іонізуючого, електромагнітного, акустичного), 

транспортних засобів, горючих, легкозаймистих і вибухонебезпечних 

речовин та матеріалів, процесів, що відбуваються при підвищених 

температурах та тиску, з експлуатацією підіймально-транспортного 

обладнання. 

Джерелами техногенних небезпек є всі небезпеки, пов'язані з впливом 

на людину об'єктів матеріально-культурного середовища. Наприклад, 

виведена людьми порода собак — бультер'єр, яка небезпечна не тільки для 

чужих людей, а навіть для свого господаря, виведені у військових 

лабораторіях бактерії, а також організми, створені методами генної 

інженерії. До соціальних джерел небезпек віднесено небезпеки, викликані 

низьким духовним та культурним рівнем людей. Це такі явища, як 

бродяжництво, проституція, п’янство, алкоголізм, злочинність, тощо. 

Першоджерелами цих небезпек є незадовільний матеріальний стан; погані 

умови проживання, революції, конфліктні ситуації на міжнаціональному, 

етнічному, расовому чи релігійному ґрунті. 

Джерелами політичних небезпек є конфлікти на міжнаціональному та 

міждержавному рівнях, духовне гноблення, політичний тероризм, 

ідеологічні, міжпартійні, міжконфесійні та збройні конфлікти, війни. Але 

більшість джерел небезпек мають комбінований характер: 

природно-техногенні небезпеки — смог, кислотні дощі, пилові бурі, 

зменшення родючості ґрунтів, виникнення пустель та інші явища, спричинені 

людською діяльністю; 

природно-соціальні небезпеки — химерні етноси, наркоманія, епідемії 

інфекційних захворювань, венеричні захворювання, СНІД та ін.; 



 

Змн. Арк. № докум. Підпис Дата 

Арк. 

 
 

ГЮЮ 3.22.053.001 ПЗ 
 
 

соціально-техногенні небезпеки — професійна захворюваність, 

професійний травматизм, психічні відхилення та захворювання, викликані 

виробничою діяльністю, масові психічні відхилення та захворювання, 

викликані впливом на свідомість і підсвідомість засобами масової інформації 

та спеціальними технічними засобами, токсикоманія. 

Проте наявність джерела небезпеки ще не означає того, що людині чи 

групі людей обов'язково повинна бути спричинена якась шкода чи 

пошкодження. До цього може призвести конкретний вражаючий фактор. 

Вражаючий фактор – це чинник життєвого середовища, який за певних 

умов завдає шкоди як людям, так і системам життєзабезпечення людей, 

призводить до матеріальних збитків. За своїм походженням вражаючі 

фактори поділяються на: фізичні, в тому числі енергетичні (ударна повітряна 

чи водна хвиля, електромагнітне, акустичне, іонізуюче випромінювання, 

об'єкти, що рухаються з великою швидкістю або мають високу температуру 

тощо), хімічні (хімічні елементи, речовини та сполуки, що негативно 

впливають на організм людей, фауну та флору, викликають корозію, 

призводять до руйнації об'єктів життєвого середовища), біологічні (тварини, 

рослини, мікроорганізми), соціальні (збуджений натовп людей) 

та психофізіологічні. 

Залежно від наслідків впливу конкретних вражаючих факторів на 

організм людини вони в деяких випадках (наприклад, в охороні праці) 

поділяються на шкідливі й небезпечні. 

Шкідливі – це чинники життєвого середовища, які призводять до 

погіршення самопочуття, зниження працездатності, захворювання і навіть до 

смерті як наслідку захворювання. 

Небезпечні – чинники життєвого середовища, які призводять до травм, 

опіків, обморожень, інших пошкоджень організму або окремих його органів і 

навіть до раптової смерті. 

Такий поділ вражаючих факторів ефективно використовується в 

охороні праці для організації розслідування та обліку нещасних випадків і 
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професійних захворювань, налагодження роботи, спрямованої на розробку 

заходів і засобів захисту працівників і т.ін. 

За характером та природою впливу всі небезпечні та шкідливі фактори 

поділяються на: фізичні, хімічні, біологічні та психо-фізіологічні. 

Поділ на джерело небезпеки, небезпечну ситуацію та небезпечний 

фактор проводиться залежно від завдання, яке ставиться, передусім від рівня 

системи «людина—життєве середовище», яка розглядається. Наприклад, 

якщо для однієї конкретної особи або групи людей вражаючим фактором є 

осколки від вибуху бомби; падіння бомб (бомбування) є небезпечною 

ситуацією, а літак, з якого здійснюється бомбування, джерелом небезпеки, то 

для рівня країни чи регіону, в якому ведуться бойові дії, небезпечним 

фактором є бомби; поява літаків, що несуть бомби — це небезпечна ситуація, 

а джерелом небезпеки є війна. 

Одне джерело небезпеки може призводити до різного роду небезпечних 

ситуацій, а останні породжують різні вражаючі фактори (газова плита – 

загроза отруєння, пожежі та вибуху). 

Сучасне життєве середовище, навіть побутове, містить багато джерел 

небезпек – це і електрична мережа та електроапаратура, система 

водопостачання, медикаменти, отруйні й пожежонебезпечні речовини, 

балкони, що знаходяться на висоті, мисливська чи інша зброя тощо. Для 

реалізації потенційної загрози необхідна тріада «джерело небезпеки — 

причина (умова) — небезпечна ситуація». 

Небезпека, як правило, проявляється у визначеній просторовій області, 

яка отримала назву небезпечна зона. 

Найбільш небезпечна ситуація для людини виникає за таких умов: 

небезпека реально існує; 

людина знаходиться в зоні дії небезпеки; 

людина не має достатніх засобів захисту, не використовує їх або ці 

засоби неефективні [28]. 
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3.2 Вплив вібрації на організм людини 

 

 Вібрація є одним із фізичних факторів, що можуть негативно впливати 

на організм людини, особливо у виробничих умовах. Тривала дія вібрації 

може призводити до різних професійних захворювань та патологічних станів. 

Вібрація буває загальною та локальною (місцевою). Загальна вібрація 

впливає на все тіло, зазвичай виникає при роботі з великим обладнанням або 

транспортними засобами. Локальна вібрація впливає на окремі частини тіла, 

зазвичай руки та ноги, наприклад, при роботі з ручними інструментами. 

Вібрація може негативно впливати на різні системи організму. В першу 

чергу, страждає скелетно-м'язова система, оскільки вібрація може 

призводити до дегенеративних змін у суглобах, зв'язках та м'язах. Це може 

викликати захворювання суглобів, зокрема артрози, а також болі в спині, 

шиї, плечах та кінцівках. Крім того, тривала дія локальної вібрації може 

викликати судинні спазми, особливо в пальцях рук, що називається 

синдромом білих пальців. Це порушує кровообіг і може призвести до 

ішемічних змін та некрозу тканин. 

Вплив вібрації на нервову систему може призвести до розвитку 

вібраційної хвороби, яка проявляється у вигляді парестезій (оніміння, 

поколювання), зниження чутливості та моторики. Порушується робота 

периферійних нервів, що може викликати неврити та невралгії. Внутрішні 

органи також можуть страждати від загальної вібрації, що може викликати 

порушення роботи серцево-судинної та дихальної систем. Виникають 

порушення вестибулярного апарату, що призводить до запаморочень та 

нудоти. 

Постійний вплив вібрації може спричинити хронічний стрес, зниження 

працездатності, порушення сну та інші психологічні проблеми. Для 

профілактики негативного впливу вібрації необхідно впроваджувати 

технічні, організаційні, медичні заходи та використовувати засоби 

індивідуального захисту. Технічні заходи включають використання 
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амортизаційних матеріалів і віброізолюючих пристроїв на робочих місцях та 

обладнанні, регулярне технічне обслуговування та налаштування обладнання 

для зменшення вібрації. Організаційні заходи передбачають обмеження часу 

роботи з вібруючим обладнанням, запровадження регулярних перерв та 

чергування різних видів робіт. 

Засоби індивідуального захисту включають спеціальні рукавички з 

антивібраційними вставками та взуття з віброізолюючою підошвою. Медичні 

заходи передбачають регулярні медичні огляди для виявлення ранніх 

симптомів впливу вібрації, а також лікувально-профілактичні заходи, такі як 

фізіотерапія та лікувальна фізкультура. Забезпечення захисту працівників від 

негативного впливу вібрації є важливим аспектом охорони праці, що сприяє 

збереженню їх здоров'я та підвищенню ефективності роботи [29]. 

 

3.3 Висновки до розділу 3 

 

Розділ 3 містить дослідження щодо впливу вібрації на організм людини 

та класифікацію небезпек за джерелом походження. За результатами 

досліджень виявлено, що вібрація може мати різноманітні наслідки для 

здоров'я людини, включаючи м'язово-скелетні розлади, порушення нервової 

системи та інші. Класифікація небезпек вібрації за джерелом походження 

допомагає визначити основні джерела вібрації, такі як машини, транспортні 

засоби або робоче обладнання, що допомагає в управлінні та зменшенні 

ризиків для здоров'я. 
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Висновки 

 

У процесі виконання кваліфікаційної роботи  було проведено всебічний 

аналіз та проектування електронного пристрою, що задовольняє задані 

технічні вимоги.  

У розділі основної частини було виконано наступне: аналіз технічного 

завдання, в ході якого визначено основні функціональні та технічні вимоги 

до лабораторного блоку живлення, включаючи діапазон вихідної напруги, 

струму та стабільність роботи пристрою; аналіз структурної схеми виробу, в 

якому розглянуто структурну схему блоку живлення та визначено основні 

функціональні вузли і їх взаємозв’язок.  

Опис принципу роботи схеми електричної принципової та її аналіз 

включав розробку і аналіз електричної принципової схеми пристрою на базі 

мікросхеми L4960, що забезпечує необхідні параметри вихідної напруги та 

струму. У розділі проектування і розрахунку вузлів електричної принципової 

схеми пристрою було виконано детальні розрахунки електричних параметрів 

ключових каскадів схеми, що гарантує їх стабільну роботу, а також 

розрахунок параметрів друкованого монтажу для забезпечення оптимальної 

компоновки і мінімізації впливу паразитних елементів. Вибір і обґрунтування 

компонентної бази передбачав вибір необхідних електронних компонентів з 

урахуванням технічних характеристик та економічної доцільності. 

Компоновка друкованого вузла пристрою включала розробку макету 

друкованої плати, що забезпечує ефективне розміщення компонентів і 

забезпечує зручність обслуговування.  

У спеціальній частині виконано обґрунтування використання та вибору 

САПР для проектування, де проаналізовано різні системи автоматизованого 

проектування (САПР) і обрано найбільш відповідну для проектування 

друкованої плати. Опис створення 3D плати виробу передбачав створення 3D 

моделі друкованої плати, що дозволяє візуалізувати кінцевий продукт і 

спростити процес монтажу та перевірки.  
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У кваліфікаційній роботі також розглянуто питання охорони праці та 

безпеки життєдіяльності при роботі з електронними компонентами і під час 

виготовлення блоку живлення.  

У результаті виконаної роботи створено лабораторний блок живлення 

на мікросхемі L4960, який відповідає всім заданим технічним вимогам та 

може бути використаний у різних лабораторних умовах для живлення 

електронних схем та пристроїв. Проведені розрахунки, проектування та 

моделювання підтвердили ефективність та надійність розробленого 

пристрою. 
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ДОДАТКИ 





1 НАЗВА КВАЛІФІКАЦІЙНОЇ РОБОТИ Й ПІДСТАВА ДЛЯ
ВИКОНАННЯ

1.1 Назва: “ Лабораторний блок живлення ”
1.2 Підставою для виконання кваліфікаційної роботи є наказ університету

про затвердження кваліфікаційної роботи № ______ від “___”______ 20 р.

2 ВИКОНАВЕЦЬ КВАЛІФІКАЦІЙНОЇ РОБОТИ

2.1. Студент Герасимчук Юрій Юрійович групи РАс-41, кафедри
радіотехнічних систем, Тернопільського національного технічного університету
імені Івана Пулюя.

3 МЕТА КВАЛІФІКАЦІЙНОЇ РОБОТИ

Метою кваліфікаційної роботи є розробка пристрою лабораторний блок
живлення, що включає в себе:

− розробка схемотехнічного рішення для даного зарядного ;
− вибір компонентної бази розроблювального зарядного ;
− розрахунок і вибір компонентів для оптимальної зарядного ;

4 ТЕХНІЧНІ ВИМОГИ

4.1. Основні параметри
4.1.1. Лабораторний блок живлення повинен бути розрахований на

живлення від джерела живлення яке видає 220 В.
4.1.2. Вихідна напруга і максимальний струм навантаження лабораторного

блока живлення повинні відповідати значенням, наведеним ПЗ.
4.2. Технічні вимоги
4.2.1. Лабораторний блок живлення повинен відповідати вимогам

стандарту, а також технічній документації на лабораторний блок живлення
конкретного типу, затвердженій в установленому порядку.

4.2.2. Лабораторний блок живлення повинен забезпечувати задану
потужність з моменту включення.

4.2.3. Лабораторний блок живлення повинен забезпечувати безперервну
роботу протягом 24 годин при номінальному струмі навантаження і номінальній
напрузі джерела живлення при нормальних кліматичних умовах.

4.2.4. Всі елементи лабораторного блока живлення повинні бути захищені
від струмів короткого замикання.

4.2.5. Електрична міцність і опір ізоляції між корпусом лабораторного
блока живлення і мережевими контактами, а також між корпусом і контактами,
повинні відповідати вимогам ДСТУ 22261.

4.2.6. За механічними, кліматичними і експлуатаційними умовами
лабораторний блок живлення повинен відповідати ДСТУ 22261 (група 4).

Граничні умови транспортування та зберігання - 5 по ДСТУ 15150. Час



витримки в нормальних умовах - 24 год.
4.2.7. У комплект лабораторного блока живлення повинно входити:

лабораторний блок живлення, комплект запасних частин. До комплекту
докладають паспорт.

4.2.8. Напрацювання на відмову повинне бути не менше 20000 год.
4.2.9. Час відновлення після ремонту повинен бути не більше 1 год.
4.2.10. Середній термін служби повинен бути не менше 6 років.

Випробування на термін служби не проводять.
4.3. Правила приймання.
4.3.1. Прилад повинен піддаватися періодичним випробуванням.
4.3.2. При випробуваннях повинен піддаватися суцільному контролю. При

невідповідності вимогам цього стандарту його повертають для усунення
дефектів. Після усунення дефектів зарядне висувають на повторні
випробування. Результати повторних випробувань є остаточними.

4.3.3. Періодичним випробуванням піддають не менше кожного типу, що
пройшли випробування. Періодичні випробування на відповідність всім
пунктам даного стандарту проводять при випуску настановних партій і
періодично один раз на два роки. При отриманні незадовільних результатів
випробувань з'ясовують причини браку, усувають їх і проводять повторні
періодичні випробування на подвоєному числі виробів. Якщо при повторних
періодичних випробуваннях виявлено невідповідність хоча б одного виробу
вимогам цього стандарту, приймання і відвантаження синтезаторів частоти
припиняють. Рішення про подальше виготовленні виробів та їх приймання
беруть замовник та підприємство-виробник.

4.3.4. Випробування на надійність проводять не рідше одного разу на три
роки. Вихідні дані при проведенні випробувань:

​- Приймальний рівень Рα = 0.95;
​- Бракувальний рівень Рµ = 0.8;
​- Ризик виробника α= 0.1;
​- Ризик споживача β = 0.2.
​
5 ВИМОГИ ДО ДОКУМЕНТАЦІЇ

5.1 Конструкторська документація повинна відповідати вимогам ЄСКД та
ДСТУ.

5.2. Комплект конструкторської документації:
− пояснювальна записка;
− структурна схема пристрою;
− електрична принципова схема пристрою;
− друкована плата пристрою;
− друкований вузол.



6 ПОРЯДОК ВИКОНАННЯ КВАЛІФІКАЦІЙНОЇ РОБОТИ

Таблиця 6.1 – Стадії та етапи виконання КР

№ етапу Назва етапу виконання КР Термін
виконання

1 Формування технічного завдання 10.03-20.03

2 Збір інформації 15.03-1.04

3 Аналіз технічного завдання 15.03-22.03
4 Створення структурної схеми 22.03-2.04

5 Аналіз структурної схеми 25.03-5.04

6 Проектування схеми електричної принципової 5.04-20.04

7 Аналіз схеми електричної принципової 15.04-25.04

8 Підбір та формування електричної бази і
компонентів 20.04-1.05

9 Опис схеми електричної принципової, її
принцип роботи 25.04-5.05

10 Розрахунок електричних параметрів елементів 1.05-10.05

11 Компоновка друкованого вузла 10.05-15.05

12 Розрахунок та компановка друкованої плати 12.05-18.05

13 Розрахунок собівартості пристрою 18.05-25.05

14 Обгрунтування використання та вибору САПР
для проектування 25.05-28.05

15 Опис шляхів збереження працездатності і
підвищення продуктивності на підприємстві 25.05-3.06

16 Формування висновків 3.06-4.06

17 Компонування кваліфікаційної роботи 3.06-9.06

18 Направлення роботи на
перевірку”антиплагіат” 10.06

19 Захист роботи 22.06

Термін виконання кваліфікаційної роботи узгоджується з керівником і з
графіком виконання.



7 ДОДАТКОВІ УМОВИ ВИКОНАННЯ ДИПЛОМНОГО ПРОЕКТУ

7.1 Під час виконання дипломного проекту в дане технічне завдання
можуть вноситися зміни та доповнення.



 ГЮЮ 2.22.053.000.001 ПЕ3
Зм. Арк. № докум. Підпис Дата
Розроб. Герасимчук Лабораторний імпульсний блок

живлення на мікросхемі L4960
Перелік елементів

Аркуш Аркушів
Перевір. Химич

Літ.
н 1 3

Н.контр.
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Конденсатори

С1 b37979-33 пФ ±5%  "Epcos" 1
С2 b41828-50 В-2,2 мкФ ±10%  "Epcos" 1

С3...С5 b37979-2200 пФ ±5%  "Epcos" 3
С6, С7 b41828-40 В-220 мкФ ±10%  "Epcos" 2

С8 b37979-1,5 мкФ ±5%  "Epcos" 1
С9 b41828-50 В-4700 мкФ ±10%  "Epcos" 1

С10, С11 b37979-1,5 мкФ ±5%  "Epcos" 2
С12 b37979-2,2 пФ ±5%  "Epcos" 1
С13 b41828-40 В-220 мкФ ±10%  "Epcos" 1
С14 b37979-2,2 пФ ±5%  "Epcos" 1
С15 b41828-40 В-220 мкФ ±10%  "Epcos" 1
С16 b37979-2,2 пФ ±5%  "Epcos" 1
С17 b41828-40 В-220 мкФ ±10%  "Epcos" 1

DА1 Мікросхема L4960  "ST Microelectronics" 1

FU1 Запобіжник ZH214-015-2 A,-250 В "Zhenhui" 1
FU2,FU3 Запобіжник ZH214-015-1 A,-250 В "Zhenhui" 2

HL1, HL2 Світлодіод L-1503GT  "Kingbright" 2

K1 Реле RT424110   "TE Connectivity" 1

Поз.
познач. Найменування Кіл. Примітка

Копіював Формат A4



 ГЮЮ 2.22.053.000.001 ПЕ3 Арк.
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Дроселі
L1 Дросель PLA10AS2221R5R2B  "Murata Manufacturing" 1
L2 НСНК-007-150mH  "Epcos" 1
L3 НСНК-007-20mH  "Epcos" 1

РА1 Амперметр AIM603000  "Velleman" 1

Резистори

R1 MFP-0,25-15 кОм ±10%   "Yageo" 1
R2 MFP-0,25-4,3 кОм ±10%   "Yageo" 1
R3 16K1-B50K-33 кОм "Song Huei" 1
R4 MFP-0,25-3,9 кОм ±10%   "Yageo" 1
R5 MFP-0,25-3 кОм ±10%   "Yageo" 1
R6 MFP-0,25-1,5 кОм ±10%   "Yageo" 1
R7 MFP-0,25-68 кОм ±10%   "Yageo" 1
R8 MFP-0,25-3,9 кОм ±10%   "Yageo" 1

Резистори нелінійні

RK1 NB-PTCO-160 - 471 кОм "TE Connectivity" 1
RU1 14D471K "Fenghua" 1

SA1 Перемикач PSM7-1-0  "Wealth Metal Factory" 1

TV1 Трансформатор ТС60 ГОСТ 11677 1

Діоди

VD1 FR607 "Diotec" 1
VD2, VD3 SR306-TP  "MCC" 2
VD4...VD7 FR607 "Diotec" 4

Поз.
познач. Найменування Кіл. Примітка

Копіював Формат A4



 ГЮЮ 2.22.053.000.001 ПЕ3 Арк.

3Зм. Арк. № докум. Підпис ДатаІнв
. №

 о
ри

г.
Пі
дп

ис
 і 

да
та

За
м. 

інв
. №

Інв
. №

 д
уб

л.
Пі
дп

ис
 і 

да
та

VD8 1N4729A "NXP" 1

XP1 Шнур мережевий LT-322 H05VV-F 3*0.75  "Lian Dung" 1
XS1,XS2 Зажим  15EDGKM-5.08-04P  "Degson" 1

Поз.
познач. Найменування Кіл. Примітка

Копіював Формат A4



 ГЮЮ 6.22.053.000 
Зм. Арк. № докум. Підпис Дата
Розроб. Герасимчук

Вузол друкований
Аркуш Аркушів
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Документация

А4  ГЮЮ 2.22.053.000 ПЕ3 Перелік елементів
А2  ГЮЮ 2.22.053.000 Е3 Схема електрична принципова 1
А2  ГЮЮ 6.22.053.000 СК Вузол друкований 1

Деталі

А2 1  ГЮЮ 7.22.053.000 Плата друкована 1
БК 2  ГЮЮ 6.22.053.000.001 Перемичка 13
БК 3  ГЮЮ 6.22.053.000.001.002 Радіатор 1
БК 4  ГЮЮ 6.22.053.000.001.003 Шпилька 2

Інші вироби

Конденсатори
5 b37979-2,2 пФ ±5%  "Epcos" 3 C12,С14,С16
6 b37979-33 пФ ±5%  "Epcos" 1 C1
7 b37979-2200 пФ ±5%  "Epcos" 3 C3...С5
8 b37979-1,5 мкФ ±5%  "Epcos" 3 C8,С10,С11
9 b41828-50 В-2,2 мкФ ±10%  "Epcos" 1 C2
10 b41828-40 В-220 мкФ ±10%  "Epcos" C6,С7,С13

5 С15,С17
11 b41828-50 В-4700 мкФ ±10%  "Epcos" 1 C9

13 Мікросхема L4960  "ST Microelectronics" 1 DA1

15 Світлодіод L-1503GT  "Kingbright" 2 HL1, HL2

Ф
ор

ма
т

Зо
на По
з. Позначення Найменування Кі
л. Прим.

Копіював Формат A4
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17 Реле RT424110   "TE Connectivity" 1 К1

Дроселі
19 НСНК-007-20mH  "Epcos" 1 L3
20 НСНК-007-150mH  "Epcos" 1 L2

Резистори
22 MFP-0,25-1,5 кОм ±10%   "Yageo" 1 R6
23 MFP-0,25-3 кОм ±10%   "Yageo" 1 R5
24 MFP-0,25-3,9 кОм ±10%   "Yageo" 2 R4, R8
25 MFP-0,25-4,3 кОм ±10%   "Yageo" 1 R2
26 MFP-0,25-15 кОм ±10%   "Yageo" 1 R1
27 MFP-0,25-68 кОм ±10%   "Yageo" 1 R7

Діоди
29 FR607 "Diotec" 5 VD1,VD4...VD7
30 SR306-TP  "MCC" 2 VD2,VD3
31 1N4729A "NXP" 1 VD8

Стандартні вироби

35 Гвинт Г2,5-6gх5 ГОСТ 17473-80 1
36 Шайба 2,5 ГОСТ 10450-78 1

Ф
ор

ма
т
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на По
з. Позначення Найменування Кі
л. Прим.

Копіював Формат A4
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 ГЮЮ 7.22.053.000 
Копіював Формат A2

1.  Плата повинна відповідати ГОСТ 23752-79.
2. *Розмір для довідок.
3.  Клас точності 4 по ГОСТ 23751-86.
4.  Крок координатної сітки 2,5 мм.
5.  Плату виготовити хімічним методом.
6.  Параметри отворів дивись в таблиці.
7.  Мінімальна ширина провідників не менше 0,4 мм.
8.  Мінімальна відстань між провідниками не менше 1,1 мм.
9.  Контактні площадки покрити сплавом "Розе" ТУ 6-09-4065-75,
    решту поверхні зі сторони провідного шару покрити компаундом
    на основі ЕД-22 ГОСТ 19587-76.
10. Плату маркувати фарбою ТНПФ-01 біла ТУ 29-02-889-88
    шрифтом 2,5 Пр 41 ГОСТ 26.020-80.
11. Інші вимоги по ОСТ 4.ГО.005.051.
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 ГЮЮ 7.22.053.000
Копіював Формат A2

1.  Плата повинна відповідати ГОСТ 23752-79.
2. *Розмір для довідок.
3.  Клас точності 4 по ГОСТ 23751-86.
4.  Крок координатної сітки 2,5 мм.
5.  Плату виготовити хімічним методом.
6.  Параметри отворів дивись в таблиці.
7.  Мінімальна ширина провідників не менше 0,4 мм.
8.  Мінімальна відстань між провідниками не менше 1,1 мм.
9.  Контактні площадки покрити сплавом "Розе" ТУ 6-09-4065-75,
    решту поверхні зі сторони провідного шару покрити компаундом
    на основі ЕД-22 ГОСТ 19587-76.
10. Плату маркувати фарбою ТНПФ-01 біла ТУ 29-02-889-88
    шрифтом 2,5 Пр 41 ГОСТ 26.020-80.
11. Інші вимоги по ОСТ 4.ГО.005.051.



44
*

31
*

65
*

70*

1

2

3
35 (1 шт.)
36 (1 шт.)

3

5 6

78

910 11

12

13

C1

C2

C4

C6

C7

C8

C9 C10 C11

C12 C13C14

C15

C16

C17

DA1

HL1 HL2

K1

L2

L3

R1
R2

R4

R6

R7

R8

VD1

VD2VD3

VD5
VD6

VD7

VD8R5

+

+

+
+

+

++

+

+

1

1

+ +

+

+

+++

Рис. 6.2

п. 4

4 (2 шт.)

90Å±2Å

5п. 3 30Å±2Å

R1

Рис. 2

3

12,5п. 3 30Å±2Å

R1

Рис. 1

2

R1

Рис. 5

2,5

4

п. 3 30Å±2Å

Рис. 3

5п. 3 30Å±2Å

5 30Å±2Åп. 3

Рис. 6.1

R1

5

п. 3
10

Рис. 4

30Å±2Å7,5

Маса Масштаб
Зм. Арк. № докум. Підпис Дата

Літ.

Розроб.
Перевір.
Т.контр. Аркуш Аркушів

Н.контр.
Затверд.

2:1

 ГЮЮ 6.22.053.000 СК

Вузол друкований
Складальне креслення

Герасимчук
Химич

н

ТНТУ  ФПТ РТ гр.РАс-41
м. Тернопіль

0,09
1

Інв
. №

 о
ри

г.
Пі
дп

ис
 і 

да
та

За
м. 

інв
. №

Інв
. №

 д
уб

л.
Пі
дп

ис
 і 

да
та

До
від

. №
Пе

рш
. в

ик
ор

ис
.

 ГЮЮ 6.22.053.000 СК
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1. *Розміри для довідок.
2. Установку і формування елементів проводити з кроком
координатної сітки 2,5 мм. Елементи формувати (установка і
формування елементів на рисунках показані в масштабі 2:1):  R1, R2,
R4...R8, L2, L3, VD1...VD8-на рис. 1; C1, C3...C5, C8, C10...C12, C14, C16-на рис.
2; С2, C6, C7, C9, C13, C15, C17-на рис. 3;  K1-на рис. 4;  HL1, HL2-на рис.
5; DA1-на рис. 6.
Мікросхему DA1 прикріпити до радіатора гвинтом поз.35.
3. Паяти припоєм ПОС61 ГОСТ 21931-76.
4. Деталі поз.4 приклеїти до деталі поз.3 клеєм ПУ-2 
ОСТ11. 054. 141-74.
5. Заводський номер, позначення елементів маркувати фарбою ЧМ,
чорна, БМ, біла, ТУ029-02-859-78.
Шрифт 2,5 по НО. 010. 007.
6. Місця розміщення маркування показані умовно.
7. Лакувати лаком АКА-113.
8. Позначення елементів показано умовно.
9. Друковані провідники умовно не показані.
10. Інші вимоги по ОСТ4ГО.070.015.


